In this part of tutorial we will concentrate mainly on creating matching tiles (ones that must fit each other, in this case - corridor tiles), adjusting the walkmesh and adding stairs.

Now, I'm assuming here that you are already familiar with two previous parts of this tutorial, so I'll skip many of things I've already explained, and pay more attention to the new stuff. There are some things we will do very often, so using keyboard shortcuts is a good idea. Switching between “Edit” and “Object Mode” - “Tab”, change viewtype between solid-wireframe-textured - “z”, hide all except selected “Shift”+”h”, unhide all - “Alt” + “h”, duplicate - “Shift”+”d”, move to another layer - “m” then click on this layer, add cut “Ctrl”+”r” and mouse wheel to add number of cuts. Of course, all this commands are also available from various menus, but it's faster to do things this way.

We'll start with corridor main tile. As usual, start with creating a plane (radius size 5). Add 2 cuts along “X” axis. Scale them along “y” axis to make the middle part wider. Use “Measure” to get the size of the middle part and the wider part.

The result should look like that:

![Image of corridor tile]

Rename the plane to *corridor_basic*. Duplicate 2 times it and rename the duplicates to *c01_main* and *c01_walk*. Move *corridor_basic* to last layer (in „Object Mode“ press „m“ and click on the lowest right layer). We will be re-using it later.

Hide *c01_walk*, so we can concentrate on shaping the geometry of the tile. Only *c01_main* should be visible. Switch to “Edit Mode” and add two cuts along “y” axis. Scale them to 2 meters width:
Extrude outer faces to 4.5 along “z” axis and delete faces you don't need:

Add one cut on each wall and move it at this same height (in this example it is 2 meters – see the red lines). This parts of the walls will have wooden panel texture:

Now add another cut at one of the walls and move it to 3 meters. Here the door will be placed later. Delete the “door” faces.
In next screenshot I added some color materials to faces, so you can imagine how this tile will look like. You don't have to do this same thing – after all, this materials won't be used in export. However, there's a nice trick to use and speed your work: you can separate the faces by material. To do that, assign materials to faces like I've shown on my screenshot below.
After assigning materials to all faces, press “a” to select them all, next “p” to separate them. Choose “By Material”:

Now the faces with other materials are separate objects you can texture and edit. Neat.
Their names are inherited from main model, so you should have \textit{c01\_main.001}, \textit{c01\_main.002}, \textit{c01\_main.003} and \textit{c01\_main}. All that's left is to rename them.
OK. Click on each to see' what part is is and rename them accordingly: \textit{c01\_black}, \textit{c01\_floor}, \textit{c01\_wood}, \textit{c01\_wallpaper}. Do this.
We could leave the mesh as it is and go straight to changing material and texturing, but that won't look good if it is without a door added in toolset. So let's do quick adjustment and extend parts of the mesh near the “door-cut”. Start with the floor part. Select the outer edge and extrude it along “y” axis, till it reaches value of -5 (you can extrude it a bit then enter -5 manually). Do this same for two other parts near the door-cut.
After the changes this tile should look like:

Now we have the part between the corridor and a room. The materials used for parts of the tile are now obsolete. In “Object Mode” select the part of the tile and click “-” next to material. Do this for every part of the tile (c01_black, c01_floor, c01_wood, c01_wallpaper)
With this done, we can add new materials & textures. Go ahead and create new materials, give them textures of your choice (well, “choice” as long as they meet NWN1 requirements ;-) The geometry of tile parts is quite simple, you don't need to create seams. “Smart UV Project” works quite good for them. So, split the Blender window and set “UV/Image Editor” as a view type for one of them. Select the part you want to unwrap, go to “Edit Mode”. Press “a” to select all. Press “u” then choose “Smart UV Project”. Depending on your texture you might want to arrange faces (move them in position, rotate and/or scale – if you don't remember how, see part 2 of this tutorial. Tip – try to use fixed amount of scaling, like “s” then “3” - this will make matching the tiles easier). As an example – here's how I arranged mine (c01_wallpaper):

And here's the whole tile after texturing:

There's another thing you might want – add a doorframe. This can be done either by creating a new object (see part 2 for that), or copying, positioning and re-parenting the frame we've already done. I'll explain the later in more detail. First, click on the layer you have the small room tile. Select “frame” and press “Shift” + “d” to duplicate (or select from “Object” menu - bottom of Blender screen - “Duplicate Objects”). Next press “m” and click the layer with corridor tile. Return to this layer by clicking on it. Now the duplicate frame.001 is in this layer. Deselect its parent (delete the name of the parent then confirm). With selected switch to “Edit Mode”. Select all faces and move it to position. You might want to change its material to this same you've used in wooden panel and arrange faces in UV/Image Editor. Add “empty” and set it as Aurora Rootdummy (tile) named htt_c01_01. Set it as the parent to all tile objects (don't forget c01_walk, which is hidden for now, but still selectable from the Scene list). Add main light named htt_c01_01ml1 and select htt_c01_01 as it's parent too.
All that’s left is the walkmesh for this tile.
To better see, which area will be walkable, hide everything except `c01_floor`. Unhide `c01_walk` and enable “Wireframe” display:

Now that you know, what the tile's walkmesh should look like, switch to “Edit Mode” and add two cuts along “x” axis and scale them till they match the width of the doorway – easily visible in “wireframe” display. Switch to “Object mode” and add “Triangulate” modifier. Don’t apply it yet. First, check, if all of diagonal lines go all in one direction.

Here's example of things going wrong:

If something like that happens, start with the easier solution – select another quad method. If this doesn’t work, you must fix it by hand – applying modifier and in “Edit mode” deleting this face, creating new one and joining corresponding verticles.

Below, this same plane with another quad method of triangulation.
It worked out. You can apply the modifier now.
Next, select the c01_walk, set it's type as AABB Walkmesh in “Aurora Mesh Properties”. Load walkmesh materials. Switch to “Edit Mode” and assign the proper materials to the faces.

This tile is ready to be exported. Time to do the other corridor tiles (the minimum for NWN 1 engine is 3 – end, middle and corner tile).
The next tile will be – corridor corner. Duplicate corridor basic, and move the duplicate to layer next to previous tile. Add two cuts along “x” axis and scale or move them – so each one is 2 meters from outer edge:

This will be the base for creating tile geometry and walkmesh. Duplicate this plane in “Object Mode”, rename one of planes c02_main, and the other c02_walk. Hide c02_walk. Extrude the faces shown below along “z” axis by 4.5:

Delete faces you won't use. You should have this geometry:

Add cuts along the walls at this same height, as before – 2m.
Now you can separate by selection: black area, wall-wallpaper, wall-wood and floor. You can do it either selecting and separating faces, or assign some temporary materials and then separate by material (btw, by default Blender doesn’t store unused materials, so if you want to have them when you open the file again, give them “fake users” - click on “F” next to them).

Parts to separate:

Rename these just created objects to `c02_black`, `c02_wallpaper`, `c02_wood`, `c01_floor`.

This time, before we will change materials and unwrap, we will do walkmesh, main light, add Aurora Rootdummy, name it `htt_c02_01`, and set it as parent to these objects.

The reason – we will use layers to match geometry and textures of the two corridor tiles we’ve created so far – and things will be easier to move and restore position, if they are all children to rootdummy. So if you accidentally move something, it’ll be easy to fix.

OK. go ahead, hide tile parts and select `c02_walk`. Set it as walkmesh, like before.

Here’s the walkmesh after triangulating and adding materials:

When all is set, unwrap the parts (use previous settings – Smart UV Project, scale this same
amount). Delete temporary materials.
The proper materials are already created, so just select them from drop-down menu:

By now you should have preliminary texturing done. Let's check if the tiles match. Select BOTH corridor layers (like with other things, select one, then click on the other, while pressing “shift”):

Select the rootdummy htt_c01_01 from the Scene list on right side of window. Press “g”, then “x” then 10. This will move all tile to right by 10, along “x” axis. Hide both tiles walkmeshes.
Now you can move and, if needed, scale faces in UV window until they match the neighbor tile.

This part of texturing might get tricky and tedious/frustrating with some pictures, so here are some tips:
- try to scale faces (in UV Editor) exactly this same amount for each tile,
- use distinct parts of the patterns, like edges of wood panels, as means of orienting textures, try to
get borders aligned with the edges of wall,
- if your tile uses more complex geometry, add some seams before unwrapping, don't leave it to program guesses. In extreme cases, separating single faces might be helpful (I've never had to to that, so far).
- make two versions of TGAs, one with grid (just add a new layer with grid) and one without it. Use the one with grid to make adjustments, and the other in your hak:

Grid in Gimp 2.8 – green square indicates “upper” and red “lower” part of the wall.

When done correctly, there's no noticeable difference between walls of different tiles.
Now we will make a dead-end corridor, by duplicating the first tile and renaming tile parts, adding a wall and modifying the walkmesh. Remember to un-hide all before you duplicate the tile.

Go to layer with `htt_c01_01`, select all, duplicate it and move to an empty layer. Rename every part, swapping c01 with c03 and deleting .001 added during duplication. The nice thing is, you already have “parenting” of the elements, so after renaming, all should be “children” of `htt_c03_01`.

First, we’ll edit “wooden panel”. Select it and hide everything else. Switch to “Edit Mode”, select two edges you want to make wall between, then press “f” to make a new face:

Adjust texture, if needed. Do this same for “wallpaper” part.

*The new parts are just at the end of the tile. You might leave it this way, if the tile next to it has not-walkable walkmesh part and "black" border.*
But there's better way. Separate the freshly created faces from both objects. Select one of them – which was a part of “wallpaper”. In “Edit Mode” move the one-face new part, along “x” axis to position, that matches the patterns on all “wallpaper” parts. Write down its “x” coordinates. Switch to “Object Mode” and select one-face “wooden panel” part. Switch back to “Edit Mode” and type in “x” these coordinates you've just used for previous object.

Next step – we will create a new “black” face. Hide unnecessary for now objects. Select c03_black and switch to “Edit Mode”. For this “Top” view is the best. Also, use “solid” display. Add cut to each part and type “x” coordinates you've used for wall parts.
Select two edges shown below and press "f" to make a new face.

Now all looks OK. What's left – is to change walkmesh. Hide everything except c03_walk. Switch to “Edit Mode”
Dissolve faces (Tool=>Remove=>Delete=>Dissolve Faces) 2 at time, like shown below:
Add one cut and move it to “x” coordinates you’ve used with wall&black parts:

Switch to “Object Mode” and add “Triangulate” modifier with “Fixed” method selected. Return to “Edit Mode” select faces near right edge and re-assign the wok to “Obscuring”. Here’s the result:

The tile is ready for export. This way, by copying, renaming and small fixes you can have a new tile in nearly five minutes!

We’ll use this same method with next tile – with stairs. First, select all objects (so – unhide all) from previous tile (hht_c03_01), duplicate and move to next free layer. Don’t delete door frame, if you have it – just un-parent it and hide. Hide all except main “wallpaper” part:
Switch to “Edit Mode” and delete the part with door-cut, so only the long wall-part remains:

Now, go back to “Object Mode” and add “Mirror” modifier with these settings:

Apply. Unhide “wooden panels and do exactly this same: remove left faces, apply “Mirror” with “y” checked. Select “floor” and go to “Edit Mode”. You should end with something like this:

Delete face shown above. Rename tile rootdummy to hht_c04_01. Change names of other models by replacing c03 with c04 (not necessary (except in mainlight- hht_c04_01ml1), but helps with recognizing, which object belongs to this tile).

Now, next thing on tile’s “to-do” list: we will create stairs model. There are many ways to do that, but I've chosen the simplest low poly model – created with “Array” modifier. Before we
start – NWN1 game engine doesn't work with 90 degrees angle. While the model can have “steps”, the walkmesh for them looks more like a ramp, than stairs. The stair height should be no more then 1,1 if you want to add standard door and your tileset is 4.5 high (door is 2x3 size). Keep that in mind while planning.

Steps to model stairs (model):
Hide everything except “floor” - this should be visible to help you with size and placement of stairs
Start with single step. In “object Mode” add a plane. Resize it in “Edit Mode”:

Extrude it along “z” axis:

When you like the result, hide “floor” part and select “Solid” display.
Delete faces, leaving only ones shown below:
Unwrap this model and add a material & texture (I used material created before for door frame), use “Textured” display to see the effects.

When you are satisfied with result, select “Solid” display again. “Array” modifier relays on “origin” point of object (the orange dot, usually in the center of it). To make stairs, we will need to change the location of “origin”. Select vertices shown below, and snap cursor to selected (quick reminder: press “space” to show “search menu then type “snap”):

Switch to “Object Mode”, press “Shift+Ctrl+Alt+c” or, if you are not a piano player ;-) just select Object=>Transform=>Origin to 3D Cursor from bottom - window menu.

Now, the fun part. Add “Array modifier” with settings:

for x,y use measurements of step. Count – how many steps you want - 6 in this example.
Make all the fixes & texturing you want BEFORE applying the modifier.

The next part depends on your concept – do you want simple stairs with the door on the landing? Or maybe you want “transition” door / area trigger? For the sake of this tutorial, I’ll make the simplest version. If you want something more elaborate, like spiral stairs, or stairs rounded, send me PM, and I’ll try to help.

OK. because this will be simple stairs, we can add some detail – railings / you can skip this part if you want “unadorned” stairs / . Before you add modifier, in “Edit Mode”, scale the step to about 50% along “y” axis. Select the upper face of the stairs, snap cursor to selected, then add a circle. Reduce vertices to 6 and resize. Move the circle where you want the first rail to be and extrude it along “z” axis.

Select all faces of extruded circle and unwrap them. Switch to “Object Mode” and apply “Array”. Now each part of the half of stairs can be edited separately. We’ll make the first railing bigger. Select all its faces, then scale it along x and y axis (exclude z axis – just press “s” then “Shift+z”). Make changes in UV window if needed, so the texture fits.

Once you’ve done that, select top edges of the first railing, then snap cursor to selected:
Add Cube and scale it, until it resembles rail beginning.
Select the side of it that faces stair and extrude:

Grab the dark blue arrow and move the face upward.
This will give you that result:

For next part some guidelines are needed.
Unhide these parts of the tile:

Stairs haven't been “parented” to tile rootdummy yet, so you can't see them on children of
`hht_c04_01` list. The stairs will be “extended” to create a “landing”. Go back to “Edit Mode” with stairs selected.
Select the edge of the last step and extrude it along “x” axis so it meets the wall:

Write down “z” location of this edge, and extrude it again, this time on “z” axis (“-”, amount you’ve just checked). Now the edge “z” location should state “0”. You can hide the wall parts now (click the “eyes” next to them).

The result:

Now click on one of the outer edges of stairs. Select edge loop (Mesh=>Edges=>Edge Loops):
Press “f” to create a new face:

Now it's time to add some finishing touches to this half of stairs. We will duplicate the last rail pole: select all its faces and duplicate (“Shift+d”), then move along “x” axis (“g”, then “x”). Select the “handrail” face and extrude it, so it will meet the wall:

Unwrap all the faces (part by part) that are untextured or textured incorrectly (1,2,3):
*In case that texture isn't showing at all, choose the proper image in UV Editor window – see next picture*
With this part done, we will apply “Mirror” modifier to add the second half of stairs. As said before, “origin point” location is important when you add modifier. We will “relocate” it to inner part. Select the inner edge loop and snap cursor to it:

In “Object Mode”, set origin to 3D cursor, like you've done before. Add “Mirror” modifier.

Here are the settings:

Apply the modifier. Change name of the object to c04_stairs and set it as child of hht_c04_01. Unhide the door frame, add it as child to this rootdummy as well. In “Edit Mode” select all the faces of the frame and move it to the new location, between railings, next to the wall.
Next – we will add a doorway in wallpaper and wooden panel. Because we want to keep UV/texturing not distorted, we will use “knife” tool. *Of course, you can do it the previous way, and fix texturing, but that means more work and time spent on the tile*/ Select the “wood panel” part of the door, Right view and wireframe display:

After you’ve clicked on “Knife” click on “corner points” of the cut (x4) Press Enter when all of them are done, and the new face will be cut. Delete it:

Do this same for “wallpaper” part. Extrude edges (wallpaper, wooden panel, stairs) along “x” axis for better look. Unwrap new faces.

There’s one more thing left – editing the walkmesh. Start by hiding all parts except c04_walk and stairs.
Dissolve faces the way it is shown below:

Add 2 cuts along “x” axis and move them to the stairs, near handrails:

Rearrange the edges (grab them and move to these positions):
Dissolve corner faces on the right.
Add cut along “y” axis and move the edges to the point handrails end:

Select the only the faces under the stairs and extrude along “z” to the height of stairs.

Grab the upper-left edge and move it along “z” then along “x” axis, to cover most of the stairs:
Triangulate *c04_walk* (Fixed method). Re-assign wok materials to faces – shown below:

And that's all it takes to make stairs. The tile is ready for export. Remember to add door coordinates, while editing .set.